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Legal & Safety Stuff 
These instructions provide important information 
concerning the proper operation of the product. Only use 
this product after carefully reading the operating 
instructions included with the product and all warnings and 
labels on the product packaging, including the manual and 
any separately included sheets. Only use this product with 
the included accessories and the included power adapter. Do 
not use this product or any Matter and Form Inc. online 
services for purposes that could infringe on the intellectual 
property of a third party. Matter and Form Inc. assumes no 
responsibility whatsoever with regard to the infringement of 
intellectual property through use of the Matter and Form 3D 
Scanner or Matter and Form Inc. online services. The Matter 
and Form 3D Scanner comes with a limited warranty, in 
addition to any warranties mandated by local laws. Details of 
the warranty can be found at 
https://matterandform.net/legal  

Matter and Form Inc. 
243 College St., Suite 401 
Toronto, Ontario 
Canada, M5T 1R5 

 

 

 

 

 

 

Please note the following important safety instructions: 

● Do not operate this product if it is damaged, or if the 
power cable or USB cable are damaged or if any of its 
internal features are exposed.  

● Only use the cables and power adapters provided 
with the scanner. If you require a replacement, please 
contact Matter and Form Inc. at 
support@matterandform.net 

● Do not operate the product when wet. If it should 
become wet, do not turn it on. Disconnect it from its 
power source and do not operate it until completely 
dry. 

● Do not touch the camera lens, laser lenses or laser 
housing. 

● If your product requires maintenance or repair, 
contact Matter and Form Inc. at 
support@matterandform.net​. Do not attempt to open 
or repair the product on your own, as it may be 
hazardous and will void your warranty. 
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FCC Class B Notice  

This device complies with Part 15 of the FCC Rules. Operation 
is subject to the following two conditions:  
1. This device may not cause harmful interference.  
2. This device must accept any interference received, 
including interference that may cause undesired operation.  

Note: This equipment has been tested and found to comply 
with the limits for a Class B digital device, pursuant to Part 15 
of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and 
can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful 
interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more 
of the following measures:  

● Reorient or relocate the receiving antenna.  
● Increase the separation between the equipment and 

receiver.  
● Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected.  
● Consult the dealer or an experienced radio/television 

technician for help.  

You may also find helpful the following booklet, prepared by 
the FCC: “How to Identify and Resolve Radio-TV Interference 
Problems.” This booklet is available from the U.S. 
Government Printing Office, Washington D.C. 20402.  

 

Modifications: Any modifications made to this device that are 
not approved by Matter and Form Inc. may void the authority 
granted to the user by the FCC to operate this equipment.  

Laser Stuff 
“Complies with FDA performance standards for laser 
products except for deviations to Laser Notice NO-50, dated 
June 24 

2007. Class 1 laser product classified under 
IEC60825-1:2007.” 
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Inside the Box 
Thank you for purchasing the Matter and Form 3D Scanner. 

Included in your box, you'll find: 

1. One (1) Matter and Form 3D Scanner 
2. One (1) AC Power Adapter 
3. Four (4) Interchangeable Power Adapter Plugs  

(set of 4 international) 
4. One (1) USB B Cable 
5. One (1) Plastic toy for first time scans 
6. One (1) Calibration Box or Card and stand 
7. Set-up Manual 
8. Electronics Documentation 
 
The scanner also features a removable plug in the center of 
the turntable bed. Removing the plug reveals a standard 
camera threaded socket that users can use to attach a tripod 
mount for holding objects in place. 
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Before You Begin 
The Importance of Lighting 
Scanning should be done in well-lit conditions. Diffuse, white 
light from  fluorescent tubes, incandescent or halogen bulbs, 
or a natural light source is best. Be aware that incandescent 
bulbs can add a yellowish tone to your final scan texture.  

Lighting situations to avoid include: 

● Spotlights or shining light directly on the object can 
cause hot spots in some areas and shadows in others, 
making it difficult for your scanner to see the lasers.  

● Uneven lighting can cause uneven textures, especially 
when aligning scans together. 

● Bright direct sunlight can overpower and wash out 
the scanning lasers, leaving fewer points recorded by 
the scanner.  

● No lights at all will cause missing and inaccurate data, 
and textures will appear black. 

● Variable lighting (lighting that fluctuates between 
bright and dark during the scan) will affect the color 
information that is gathered, making the textures 
look striped.  

For more up-to-date tips and tricks, visit our website. 
www.matterandform.net/help 

 

Problem Materials and Surfaces 
There are some materials that laser scanners have trouble 
scanning. Because the scanner works by capturing the data 
that is made by the laser hitting the surface of the object, any 
material that makes the lasers difficult to see will not scan 
well.  

Here are some materials you cannot scan without prepping 
first: 

● Objects with surfaces that are too shiny (i.e. metal, 
jewels, mirrors etc.) will reflect or bounce the laser 
away from the object. This can cause noisy looking 
scans. 

● Objects that are clear or translucent (i.e. glass, clear 
plastic, flower petals, jello etc.) will let the laser light 
pass right through the surface of the object. This can 
cause scans that appear to have two layers. 

● Objects that are too dark and absorb too much light 
(i.e. black velvet, fur) will also absorb the laser light 
causing an inaccurate scan. This can cause your scan 
to appear empty. 
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Preparing Your Object for Scanning 
Some objects (as listed above) will require a bit of prep work 
to allow them to scan properly, or at all. Pre-treating your 
objects with matte paint, foot sprays or baby powder will 
give the best results. If using paint, a light grey color is best.  

If you want to capture color data, be aware that any 
treatment may alter the color as it appears in the final scan. 

Download and Install 
Download the MFStudio software from 
www.matterandform.net/download​.  

If you don’t already have an account you’ll be prompted to 
register your email.  

Make sure to download the appropriate software for your 
computer!  

Follow the setup wizard and complete the install process. 

Language Options 
To localize MFStudio in Italian, French, Spanish, Portuguese, 
German, Chinese (Traditional or Simplified), or Arabic:  

Click ​Options ​ in the Tools menu in the Windows software, or 
select ​Preferences ​ from the MFStudio menu in the Mac 
software. 

Choose a language from the ​Language​ drop down list. 

Close and reopen MFStudio to change to the new language. 

Setting Up Your Scanner 
Choose a location close to your computer that has even, 
ambient light and a stable, level surface. The first step is to 
connect the scanner: 

1. Plug the USB Type A connector end into the 
computer; 

2. Plug the USB Type B connector end into the scanner; 
3. Connect the power cable to the scanner and plug the 

power cable into a surge protector; 
4. Open the scanner on by gently depressing the release 

button on the top of the scanner and swing it open, 
revealing the scanner head and the turntable. Turn 
the handle 90° until it locks in place as the scanner 
leg. 

5. Power the scanner on. To do so, push the MF logo on 
the lower front of the scanner until it lights up; 

6. Open the software. The software will search and 
detect the scanner. Once it does, you’re ready to start 

Before you perform 
your first scan, you 
must calibrate your 
scanner. Go to 
Calibrating the 
Scanner​ for 
step-by-step 
instructions.   
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MFStudio 
Starting a New Project 
To start a new project, click ​New Project ​on the MFStudio 
homepage. Enter a ​Filename ​, select a ​Save to: ​ location, 
then click ​Continue ​. 

To open a project, click the thumbnail of a recent project on 
the MFStudio homepage, or navigate to ​Open ​ from the File 
menu. 

 

 

Calibration 
Calibrating the Scanner 
Calibration is very important to getting the best out of your 
scanner.  From time-to-time or with brand new scanners, 
MFStudio will remind you when it’s time to calibrate, but you 
can calibrate whenever you need to by selecting ​Calibrate 
from the File menu. 

Calibrate your scanner when it gets moved or 
your lighting changes drastically! The turntable 
can shift when moved, causing the scanner to 
scan incorrectly.  

 
Click to select the calibration device, card or box, that came 
with your scanner.  Follow the instructions to assemble the 
card, if needed.  
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Follow the instructions for Calibration Steps 1 and 2 in the 
software to calibrate you scanner. 

 

The scanner turntable will rotate left and right, firing its 
lasers and collecting a range of data. Be patient and do not 
move the calibration card or scanner.  

Step 2 will take slightly longer than Step 1 as the software 
compares the data between Step 1 and Step 2. 

 

If your calibration is interrupted or fails, an error 
message should appear. Make sure your lighting 
environment is ideal and the scanner is properly 
setup before trying calibration again. 

 
If a step in calibration takes longer than 30 minutes, stop the 
calibration and try again or contact 
support@matterandform.net​ for tips and assistance. 
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Scanning 
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Starting a New Scan 

 

Click ​+new scan​ to start a new scan. Clicking the tabs from 
the top of the sidebar on the Scan Setup page will let you 
choose between scanning modes: 

 

 

   

Regular Scan 
Regular Scan ​(10-15 minutes per pass) uses two lasers to 
capture geometry with optional textures.   

Regular scan uses a process called “Adaptive Scanning”, in 
which the bed will rotate forward, but will also rotate back. 
This is to capture extra data when the distance between new 
and previously captured points is determined to be too 
great. 

+Quickscan 
+Quickscan ​(1-2 min per pass) uses one laser to capture 
geometry. Click the Laser 1 and Laser 2 buttons under 
Geometry Settings to choose which laser to scan with. 

 

Laser 1 is farther from the camera than Laser 2. Choosing 
Laser 1 may result in greater accuracy, but capture less of the 
object (due to the shadow the laser will cast), while choosing 
Laser 2  may result in less accuracy, but more coverage. 

See the following sections for information about ​Geometry 
Settings​ and ​Texture Settings​. 
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+Quickscan is only available for purchase through MFStudio, 
or at the time you bought your scanner. ​See ​ +​Quickscan 
Purchasing and Activation​ for more info ​. 

Geometry Settings 

 

The Geometry Settings can be found at the top of the Scan 
Setup sidebar. The slider controls the camera’s exposure, 
making the laser lines visible for capturing an object. Laser 
lines will bounce off different colours and object materials 
differently, influencing how well it will capture information. 
Changing the camera’s exposure can make the lasers more 
or less visible. 

One or two red lasers will be visible in the camera view. The 
additional green overlay represents how the scanner sees 
the lasers, ie. where your object is being detected. Adjusting 
the Geometry Settings slider will change how easy it is for the 
scanner to see the lasers. 

To find the best exposure for your object,​ choose an 
exposure where the green overlay is a sharp line, meaning 
that it doesn’t have a lot of noise. Noise appears as fuzzy 
static rather than a straight solid or nearly solid line. The 
more defined and filled in the laser line the better the results.  

If your laser line detection is poor at every exposure, adjust 
your lighting environment.  

Dark-colored areas need a bright camera exposure 
and light-colored areas need a darker camera 
exposure for the best laser line detection.  

 
Picking the Best Laser Exposure 

 

 

Here is an 
example of noisy 
laser lines with 
gaps. 

 

 

Here the gaps are 
closed. This is a 
good set of laser 
lines. 
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When more than one exposure gives good results, 
choose the lowest value, as this reduces total 
scanning time and the capturing of noise points 
from the scan bed.  

 
High Contrast Scanning (Regular scan) 
High Contrast Scanning is a method for capturing the best 
data possible when scanning objects with more than one 
color, particularly contrasting colors, like black and white. 
High contrast scanning allows for improved laser detection 
by tuning two different exposures, one for each contrasting 
color.  

Click the ​High-Contrast​ checkbox in the Geometry Settings 
toolbox to turn on high-contrast scanning.  

How Do I Identify High Contrast Objects?  
Use high contrast If your object has 
colors from both of these 
categories: 
1) Blue, Purple, Dark Green, Black 
2) Yellow, Orange, Red, Grey, White 
(and pastel colors) 

Try High-Contrast, if the green visualization overlay for the 
lasers in the Geometry camera feed does not achieve a 
complete line when adjusting the Geometry Settings slider. 
 
 
 
 

Setting High Contrast Laser Exposures 

 

Some models cannot be 
scanned with only one laser 
exposure due to their high 
contrast colors: grey and 
white both contrast with 
black. 

 

Here you can see the laser 
lines when a darker 
exposure is selected. One 
color shows well, but the 
other doesn’t. 

 

Here you can see the laser 
line shows up well on the 
black, but is spotty on the 
white.  

To set a different exposure for each colour, first adjust the 
top Geometry Settings slider for ​Exposure 1​ to capture clean 
laser lines on the light areas of the object.  
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Check the ​High-Contrast ​checkbox, which enables the 
second exposure slider. 

Then, adjust the bottom slider for ​Exposure 2 ​ until the dark 
areas of the model fill in with a clean laser line.  

 

Here you can see the two 
laser lines showing clearly 
on both colors.  

 

 

 

Changing exposures may take time to reflect in the 
Geometry camera feed, so you may need to wait a 
moment to see the results. 

 
   

Texture Settings 
Texturing captures color information from photos taken 
during scanning and applies them to the generated point 
cloud. Textures can be enabled for meshed scan projects, 
and included when exporting/saving to MFPROJ or OBJ file 
formats. 

To capture textures, check​ Capture​ in the Texture Settings 
toolbox. The Texture camera feed (displayed in color as a 
thumbnail within the Geometry camera feed) shows the 
exposure that will be used for texturing. Look at this feed 
when adjusting the Texture Settings slider.  

 

Adjust the slider until you find an exposure where an object’s 
colors appear realistically. You want an exposure that shows 
the colors on the object in a bright but not overexposed 
manner. 

Textures for a ​Regular Scan ​ are capturing during the same 
bed rotations as the scanning operation. 

Textures for a +​Quickscan ​ are captured during an additional 
bed rotation after geometry is captured. 
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Picking the best exposure for color 
Here are three examples for Texture Settings exposures:  

 

This is underexposed. 
Capturing textures with this 
exposure will result in a 
fairly dark object.  

 

This is a good choice for 
capturing color because the 
object is evenly lit with 
minimal shadows and hot 
spots.  

 

 

This is overexposed. 
Capturing textures with this 
exposure will result in hot 
spots and uneven colors. 

 

Scan Path 
Adjusting the sliders in the Scan Path toolbox will restrict 
scanning to only a portion of the object. 

 
 

● Height: The vertical slider sets how high the camera 
head will move - each block of the slider represents 
another height at which the camera head will stop to 
complete a bed rotation (or pass) to capture points. 

If unsure of the appropriate scan path height for 
your object, leave the slider full and cancel the 
scan’s progress when your object is completely 
scanned.  It will load in the Project Editor as is. 

● Degree: The horizontal slider sets the degree of bed 
rotation for each pass (45° minimum). Moving this 
slider will restrict the scan bed’s rotation in order to 
scan only a portion of an object.  

Click ​Scan ​when you’re happy with your settings. 
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Bed Step Override 
The Bed Step Override feature controls the capture 
frequency of 3D points during the scan bed rotation. Moving 
the slider to the left or right will decrease or increase the 
degree size between captures. The lower the degree size, the 
more points are captured. The higher the degree size, the 
fewer points are captured. So, moving the slider to the left 
captures the most points, and moving it to the right captures 
the fewest. 

 

To turn on this feature in the Windows MFStudio software: 

1. Click ​Options ​ in the Tools menu to open the 
Preferences window. 

2. Check ‘Enable advanced options’. 
3. Close the Options window.  

For Mac users, open the Preferences window by selecting it 
from the ​MFStudio​ menu, then check ‘Enable Advanced 
Options’. 

Scan Progress 
The Scan Progress window displays points as they are 
captured during scanning. 

 

Click the ​X​ icon by the progress bar to finish scanning at any 
time. The scan will load into the Project Editor as-is. 
 
You can interact with the point cloud while scanning: 

To SPIN: Click and drag anywhere in the view window. 

To ZOOM: Use the mouse wheel, or scroll, to zoom in and 
out. 

To PAN: Right click and drag. 

To RESET VIEW: After clicking the view window, press the "c" 
on your keyboard. 
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Editing 
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Project Editor 
The Project Editor is designed for working on multiple scans 
of the same object simultaneously (though it functions the 
same with a single scan).  

Sometimes a single scan can miss a feature of an object, like 
the bottom or top, that can be captured by performing 
another scan at a different angle (i.e. with the object on its 
side). 

To add an additional scan to your project, click ​+new scan​. 

From the Point Cloud Control toolbox you can: 

 
Click to turn on/off visibility. Scans must be visible 
to clean or align them. 

Click to delete a scan from the project. 

 
Click to turn on/off alignment. Scans will align to the 
first scan selected.  

 

   

Aligning Scans 
The most effective way to get complete geometry of an 
object is to scan it from different angles and align the 
resulting point clouds together in the Project Editor. 

It’s a good idea to clean your point clouds before aligning 
them.  

Choose the point cloud in the desired orientation.  

To begin the alignment process, click ​A​ on a point cloud in 
your desired orientation. This scan will be used as the 
reference for the next scan’s alignment. Subsequent scans 
chosen for alignment will use all the previously aligned scans 
as their reference.  

Alignment may take a few minutes depending on the size 
and complexity of the point clouds.  

Occasionally the alignment algorithm identifies 
the wrong key points for aligning scans together, 
particularly with symmetrical objects. When 
alignment fails in this way, try aligning your scans 
in a different order. 
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Cleaning Scans 
The scanner can pick up unintended points caused by 
reflections off the surface of the object or captured 
background movement. The turntable can also be captured, 
especially if the object’s color is similar to that of the bed.  

There are three options for cleaning tools in the sidebar of 
the Project Editor: Noise, Brush, and Crop. Points selected by 
any of these methods will be highlighted in red. Click ​Clean 
to delete the highlighted points, or ​Deselect ​to keep them.  

Undo ​, in the Edit menu, restores points that have been 
cleaned. 

All points can be removed, including good points. 
Rotate the model to make sure only unwanted 
points are highlighted. You can use the mouse 
wheel, or scroll, to zoom in for a closer look. 

 

   

Noise Tool 
The ​Noise Selection​ tool automatically highlights points for 
cleaning. Move the slider to choose how aggressive the 
selection will be.  

 

 
 
 
 
Points selected 
with the Noise 
Selection slider 
set in the middle. 

 

   

20              



 

Brush Tool 
The ​Brush ​ tool manually selects (+) or deselects (-) points. 
Control the brush size using the square bracket tools ] and [. 
The hand button returns regular mouse functionality. 

 

 

 
Before: Unwanted 
points individually 
highlighted 

 

 

 
After: Unwanted 
points deleted 

Crop Tool 
The ​Crop​ tool removes all points outside an area you specify. 
Use the sliders to choose points from the top down, the 
bottom up, or moving towards the center. 

 

 

 

Points to be 
removed are 
highlighted in red. 

 

 

Result after clicking 
“Clean”  
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Meshing 
To mesh a project for export, navigate to the Mesh tab within 
the Project Editor. The Mesh Options slider controls the level 
of detail in the mesh: to the right for lots of detail, to the left 
for low detail. 

If textures have been captured for the project, check ​Enable 
Texture ​to texturize you ​r mesh. Textures are processed 
using the GPU by default. On computers without GPUs or 
with incompatible GPUs, texture processing will 
automatically switch to using the CPU.  You can also check 
Force CPU Texturing ​ in the Preferences menu to always use 
the CPU. 

Click ​Mesh ​. 

The ideal level of detail for meshing may vary by 
object and project. Further changes made to 
point clouds will not be reflected until ​Mesh ​is 
clicked again.  

 

 

 

Detail level 6 

Meshing with a 
low level of 
detail results in 
fewer, larger 
polygons and 
create a very 
smooth surface.  

 

 

Detail level 8 

Surface is 
smooth and 
detail is 
accurate. 
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 Detail level 9 

Meshing with a 
high level of 
detail results in 
a dense polygon 
count that may 
make surfaces 
appear rough 
depending on 
your object.   

 
Mesh Info Panel 
The Mesh info panel displays 
mesh measurement 
information: volume, surface 
area and face count, as well as 
bounding width, height, and 
depth dimensions. 

 

 

 

   

Save and Export 
Saving Your Project 
To save the project file, select ​Save​ from the File menu. Files 
are saved with the ​.mfproj ​file extension. ​.mfproj ​files can 
only be opened with MFStudio. The ​.mfproj​ file format is 
proprietary to Matter and Form and is the quickest and 
easiest file format for the software to use.  

Exporting 
To export your project in a different file format, select ​Export 
from the File menu.  

● Exporting with the Point Cloud tab open in the Project 
Editor will allow exporting point cloud file formats, 
like PLY or XYZ.  

● Exporting with the Mesh tab open will allow exporting 
in other file formats requiring meshed models, like 
OBJ or STL.  

All file format units are in millimeters. Exported files cannot 
be re-imported. 
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Export file formats include:  

FILE 
TYPE  DESCRIPTION 

XYZ 
(point 
cloud) 

Use XYZ when working with CAD modeling 
programs. XYZ is the most basic point cloud format, 
and stores points on a Cartesian coordinate system 
with X, Y, and Z axes. XYZ does not save colour 
information. 

PLY 
(point 
cloud) 

Use PLY when working with programs like Meshlab. 
Like XYZ, PLY exports the point cloud as individual 
points. Unlike XYZ, PLY will store the point colors 
that were captured when scanning with regular 
scan.  

OBJ 
(meshed) 

Use OBJ when working with animation or 3D 
printing programs. OBJ will only store your final 
mesh. OBJ exports contain multiple files, so be sure 
to export to an empty folder. OBJ and GLTF are the 
only file formats that will export textures. 

STL 
(meshed) 

Use STL when working with CAM or 3D printing 
programs. STL exports are watertight and printable 
in most cases. Some editing may be required to 
flatten or hollow your mesh before printing. 

GLTF 
(point 

cloud or 
mesh) 

Use GLTF when you need a small, quick-loading file 
for game development or digital display. GLTF is a 
new format that supports realistic textures.   

DAE 
(meshed) 

Use DAE when moving 3D models between 
software programs with incompatible file formats, 
as it stores meshes (without textures) as XML files. 

Upload to bevelPix 
On the Mesh tab you’ll find the Upload to bevelPix toolbox. 
bevelPix is Matter and Form’s cloud service platform for 
viewing and sharing 3D content. bevelPix is a great way to 
share your creations as links or embeds on social media 
sites.  
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Pro Tips 
Positioning your laser 
Laser scanning operates on a sight-line principal: whatever 
the lasers cannot touch and the camera cannot see, the 
scanner cannot capture. For example, it would be able to 
scan the outside of a straw but not the inside.  Like a photo 
camera, the scanner can only capture what is in its field of 
view. 

Organic shapes: curves, surface detail, outer geometry is 
easier to capture. Deep depressions and overlapping 
features, however, are difficult for the scanner to capture 
accurately.  
 
Use the Geometry Settings camera feed on the Scan Setup 
page to preview how the laser lines are hitting your object -- 
this will change depending on where it’s positioned on the 
bed (center or off-center) and how it is angled. Tilt, pan or 
rotate your object on the scan bed using your hand while 
looking at the camera feed to check where your object is 
being seen by the laser.  
 
Use some plasticine or tack to stabilize your object at the 
angle and position with the best laser coverage (for longer, 
thinner objects try standing them upright with plasticine) . 
You can clean the scanned plasticine with the brush tool.   

 

 
Try positioning your object off center or on a diagonal across 
the scanner bed for longer objects. The lasers will sweep 
across your object and add more coverage.   
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Symmetrical Objects 
Some objects are too symmetrical for the software to 
correctly align them.  

One solution is to use tack, plasticine or anything that can 
create a geometric marker on your object, making it easier 
for the software to correctly align the scans. Then after 
aligning, use the brush tool to remove those points. 

+Quickscan, then Regular Scan 
An efficient workflow worth trying is to initially scan with 
+Quickscan to generate point clouds of an object’s basic 
geometry, then, with the knowledge gained from your recent 
scanning experience with that object, set up a Regular scan 
in the optimum position to generate any extra detail and 
hole-filling that’s needed. 

   

Using other software with your scanner 
For some purposes, scan projects may require some extra 
clean-up or geometric sculpting beyond what MFStudio can 
provide. MFStudio exports point clouds and meshes in a 
variety of file formats compatible with other software 
programs (see ​Saving and Exporting Scans ​).  

Check the import settings within the software program you’d 
like to use and choose a compatible export format. You can 
control the size and number of faces of your mesh by 
lowering and raising the level of detail using the slider in the 
Mesh toolbox.  

3D printing 
To 3D print a scan you’ll first need to mesh the point cloud 
(see ​Meshing​) and export the project as either an OBJ or STL 
file. Both these file formats create watertight meshes 
capable of being 3D printed.  

Check the file format restrictions of your 3D printer software. 
You can adjust the spatial size of the mesh once it’s opened 
in the 3D printer software.  
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3D Lingo 
A point cloud is a set of data points in a coordinate system. In 
a three-dimensional coordinate system, these points 
represent the external surface of an object and are usually 
defined by X, Y, and Z coordinates. 

There are five essential terms that are used to describe 
elements of a given point cloud: vertices, edges, faces, 
polygons and surfaces. 

Vertices 

 

A vertex is a position. It 
includes additional 
information such as color, 
normal vector, and 
texture coordinates. 

Edges 

 

A connection (i.e. a line) 
between two vertices is 
an edge.  

Faces 

 

A face is a closed set of 
edges. It can be 
categorized as a triangle 
face (three edges) or a 
quad face (four edges). 

Polygons 

 

 

If a collection of faces all 
exist on a single 
geometric plane, this one 
collection of faces is 
labeled as a polygon. 

Note:​ ​Polygons and faces are 
equivalent in software 
platforms that support 
multi-sided faces. However, 
most rendering systems 
support only 3- or 4-sided 
faces. So polygons are 
represented as multiple faces. 

Surfaces 

 

Surfaces connect 
neighbouring polygons 
together. Also called 
smoothing groups. 
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+Quickscan 
Purchasing and 
Activation 
Purchase +Quickscan 
On the +Quickscan tab in the Scan Setup page, click the 
Upgrade to +Quickscan ​ button. 

Fill in the information requested in the purchase dialog box, 
including payment option.  

Once payment is received, a dialog box will open with a 
thank you message where you can click to ​Start using 
+Quickscan ​! 

Activate / Deactivate +Quickscan 
Go to the +Quickscan tab in the Scan Setup page and click 
the ​Activate +Quickscan ​button. 

Enter the 12 digit serial number on the bottom of your 
scanner, or the 24 digit serial number emailed to you after 
purchasing quickscan,  and click​ Activate​.  

 

Your +Quickscan license can only be active on one computer 
at a time. To use +Quickscan on a different computer you 
must first deactivate the feature on the first computer.  

Deactivate +Quickscan by selecting ‘Deactivate / Activate 
+Quickscan’ from the MFStudio program menu and click 
Deactivate​ in the dialog box that appears. 

 

Once MFStudio has been installed on the new computer, 
activate +Quickscan by following the activation steps as 
outlined above.   
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Our Roots 
We are designers and programmers from Toronto who 
needed a high-res 3D scanner but couldn’t afford one, so we 
built our own. Determined to help others enhance their 
creative, professional and recreational lives, we launched a 
record-breaking Indiegogo campaign backed by designers, 
architects, hobbyists, gamers, teachers and creative families. 

At the heart of our scanner’s technology is a high-definition 
camera that produces accurate, detailed color scans at 
resolution qualities that match or top what more expensive 
scanners can achieve​. It creates files for any 3D printer ​or 
online printing service, supports Windows and Mac OS, and 
allows users to scan solid items to create basic scans quickly 
and with little effort. It is also capable of exporting intricate, 
high-resolution, 3D representations for use in any number of 
digital 3D applications. 
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